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- Clock, Display & Sounds

Clock
e b => Settings = (8] => Clock => (m]
Hide Clock => Clock Display => (8] => Display => (8] => OFF => (m]
Clock Size => Clock Display => (] => Size => (] => Select a size => (m]
Clock Color => Clock Display => (] => Color => (8] = Black or White => (u]
Set Auto Time Adjustment => Set Main Time => (8] => Auto Time Adjust => (8] => Auto => (8] =>
Select a time zone = (®)
+ Press &) to change city/area name in Time Zone Selection field.
Manually Adjust Time => Set Main Time => (8] => Auto Time Adjust => () => Manual(Date Time
Set) = (] => Select a time zone => (@] = Enter date and time = (@]
Summer Time => Set Main Time => (8] => Summer Time => (&) => ON => (&}
n Time Zone (Sub Clock) => Set Sub Clock => (8] => Display Method => (8] => Always => (&) =>
£ Select a time zone = (®]
-,
g Hide Sub Clock => Set Sub Clock => (] => Display Method => (8] => OFF => (m]
E' Summer Time (Sub Clock) => Set Sub Clock => () => Summer Time => (8] => ON => (®]
=
o  Time Zone Major City (Sub Clock) => Set Sub Clock => (8] => Area Name => (] => Display => (u]
=]
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- Clock, Display & Sounds

Alarm

fe) => Settings => (8] => Clock => (m]

Set Priority at Alarm Notification Time

=> Alarm Setting => () => Operation Preferred or Alarm Preferred => (m]

Change Alarm Tone

=> Clock Alarm Tone Set => (] => Select an item => (] => Set an alarm
tone

Auto Power On/Off

Set Auto Power On/Off

(e => Settings => (8] => Clock => (8] => Auto Power ON or Auto Power
OFF => (m] => ON => (] => Enter time => () => 1 Time or Daily = (u]

Style Mode Settings

[ = Settings - (8] > Style Mode Setting > (u)

Set Display Design Collectively

= Select a style = (8] => YES => (m] (=> YES => [m))

Check Default Style Mode Settings

=> Select a style =
« Details of some items can be checked by selecting an item and pressing (&).

Edit Title of a Style

=> Select a style = (@) => Edit Title => () => Edit title => (m]

Save Current Style Mode Settings as
Favorite

= BICA D (Favorites) = (2] = (@) => Take Setting Info => (8] => YES =>

(w)

+ The current style mode settings can later be recalled collectively from S&ICAD
when they are changed.
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- Clock, Display & Sounds

Change Each Item for Favorites = BFICA D (Favorites) = (B = Select an item => 8] => Set an image
Clear All Favorite Settings => B5/CA D (Favorites) = (@) => Reset Setting Info => (8] => YES => [m]

Display Settings
[y <> Settings > (8) <> Display —> (W)

Wallpaper => Display Setting => (] => Stand-by Display => (8] => My Picture or
Videos => W) => Set an image/video (=> Select a layout => (8] (twice))
Show Calendar in Standby => Display Setting => (8] => Stand-by Display => (8] => Calendar => (®] =>

Background => (8] => Set an image = Select a layout => [®] (twice)

+ Select No Background if you do not want any image in the background of the
calendar.

+ Press (m], use (@) to select the calendar and press (®] to operate it. Use (@) to switch
to the previous/next month. Press (@] to activate Schedule.

o) Set Random Display of Images in => Display Setting => (8] => Stand-by Display => (8] => Random Display =>

w  Standby (@) = Select a folder => (] => Select a layout = (8]

g - Images switch at random each time handset is opened or returns to Standby.

E' Set a Wake-up Image => Display Setting => (] => Wake-up Display => (8] => My Picture => (m]

g. => Set an image

3 Seta Wake-up Message => Display Setting => (B8] => Wake-up Display => (8] => Message => (8] =
_m Enter message = (8]
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- Clock, Display & Sounds

Set an Outgoing Call/Message Image

=> Display Setting => (8] => Djaling, Video Call Dialing or Mail Sending =>
(@) = Set an image

Set an Incoming Call, Message Image
or Video

=> Display Setting => (] => Calling, Video Call Calling or Mail Receiving
=> (W) => Select Calling Disp. or Select Receiving Disp. => (8] (=> My
Picture or Videos => (®)) => Set an image/video

Set an Image for New Messages or
Received Result Window

=> Display Setting => (B) => Retrieve New or Mail Rec’d Result => (8] =>
Set an image

Display Color Scheme

=> Display Design => [8) => Color Theme => (] => Select a color => (m]

Set a Battery Level Indicator/Signal
Strength Indicator Pattern

=> Display Design => (8] => Icon Pattern => (8] => Battery Icon or Antenna
Icon => (@] => Select a pattern = (m]

Change Softkey Color

=> Display Design => 8] => Soft Key => (8] => Select a color => [m]

Set Font Type

=> Font => (8] => Font Type = (8] => Gothic or Ming-cho => (8]
- Alternatively, press and hold in Standby to make font settings.

Set Font Thickness

=> Font => (] => Thickness => (8] => Thin or Bold => (]
+ Alternatively, press and hold in Standby to make font settings.

Set Font Sizes Collectively

=> Font => (] => Character Size => 8] => Standard or X-large => (]

+ Items settable with Separate Setting for Character Size can be set collectively.
+ Alternatively, press and hold in Standby to make font settings.
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- Clock, Display & Sounds

Set Font Size for Each Function => Font => (W) => Character Size => (8] => Separate Setting => (8] => Select
Window a window => (8] => Select a size => (W] =>

+ Alternatively, press and hold in Standby to make font settings.

+ In PC Site Browser, this procedure is only available in Small Screen view.

Interface Language => SZER ~ (W) => F&EZ or English = (m]

- To change interface language from Japanese to English:
> o) > ZFE > (W) > Fr X TL 1 <> (8] => Language => (8] => English => (m]

Set Image List View => Viewer Settings => (8) => Picture or Title => (u]

Guard from Prying Eyes => Privacy Angle => (8] => ON => (m]

- Alternatively, press and hold in Standby to toggle Privacy Angle on and off.
+ When Privacy Angle is set, Display is whitish and the viewing angle is narrower.
+ Turning power off/on cancels Privacy Angle.

Show Information of Messages => Quick Info Setting => (W) => Display Sender or Display Sender/Subject
Received When Watching TV = (m]

Set 3D Effect When Returning to => Screen Effect => (W) => Select an item => (®]

Standby

Display Quality => Image Display Mode => (8] => Normal, Vivid or Dynamic => (u]

- The Visual Image Effect setting in TV Effect has preference for TV display quality.
+ A preview image for each mode appears during selection in Image Display Mode
to check the effect.

_m Charging Display (Handset Closed) => Display On Charge => (8] => Wide Stand-by Clock, Photo Slide-show
or OFF => (m] => Select a folder = [m]
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- Clock, Display & Sounds

Backlight

fe) => Settings —=> (8] => Display => (8] => Backlight => (u]

Set Backlight & Power Saving

=> Lighting => (8] => ON or OFF => [®] (=> Select time Backlight is lit = [m])
=> ON or OFF => [®] (=> Enter a time before the Power Saver Mode is
activated)

+ Press and hold (5 to toggle TV Power Saving on/off.
+ When the Power Saver Mode is activated, nothing appears in Standby and Keypad
backlight flashes. Pressing any key cancels the Power Saver Mode.

Set Backlight during Charging

=> Charging => (8] = Standard or All Time ON => (]

Set Brightness of Backlight

=> Brightness => (8] => ON or OFF => (8] => Select a Level => (1]

+ Set Brightness to Level 6 to use Display with the maximum brightness. Backlight is
Level 4 by default. A higher setting reduces battery life.

Desktop Icons

fe) = Settings => (8] => Display => (u]

Set Desktop Theme

=> Desktop Icon => (] => Select a theme => (8] => YES => (m]
+ Press (2] to see details of the selected theme.

Change Icon Design of a Theme

=> Desktop Icon => (8] => Select a theme => (&) => Select an icon = (@) =
CHG Icon Image => 8] => Select Icon Image or Default Icon Image => (8]

=>Set an icon
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- Clock, Display & Sounds

Change Order of Icons of a Theme => Desktop Icon => (B] => Select a theme => (8] => Select an icon => (@) =
Sort => (@] => Select a position = (m]

Copy Icons to Another Theme => Desktop Icon => (] => Select a theme => (&) => Select an icon = (@) =
Copy => (m] => Copy This, Copy Selected or Copy All => (8] => Select a
destination theme = (@) (=> Select icons = (8] = @)

+ When Copy Selected or Copy All is selected, select YES and press (8] at the end of
the procedure.

Move Icons to Another Theme => Desktop Icon => [B] => Select a theme = (8] => Select an icon = (@] =>
Move => (@] => Move This, Move Selected or Move All => (8] => Select a
destination theme => (8] (=> Select icons => (@] => (&) => YES => (=)

Delete Icons of a Theme => Desktop Icon => (m] => Select a theme => (8] => Select an icon => (@) =
Delete => (W) => Delete This, Delete selected or Delete All => (®] (=> Select
icons = (@] = [&)) = YES => (@]

Show New Message Indicator as 3D | => 3D Display Setting => (8] => ON => (u]
Animation

Menu Display Settings

f) = Settings => (8] => Display => (8] => Menu Display Set =>(m]

List View and Details View => Menu Display => (8] => List or Detail => (]
- Select View for menus from f=> Settings = (m].
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Set Main Menu Theme => Theme => (®] => Select a theme => (®]
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- Clock, Display & Sounds

Change Icon Design (Original Theme)

=> Theme => (8] => Original Theme => (8] => Select a menu item = (] =>
Set an image
+ Change Main Menu icons to any preferred image.

Change Background (Original Theme)

=> Theme => (] => Original Theme => W) => Background Image => (] =>
Set an image
- Change Main Menu background to any preferred image.

Reset Original Theme Settings

=> Theme => (8] => Original Theme => (8] => Select a menu item = (@) =
Reset or All reset => (8] => YES => (m]

+ This procedure is only available when any Original theme settings have been
changed.

Save Last Selected Menu Item to
Memory

=> Memory Focus => (8] => ON => (m]

D= - &

Add a Menu Item to Original Menu

=> <Not Recorded> => (&) => [} to select a function => (m]

Change Order of Original Menu Items

=> Select an item => (@) => Sort => 8] => Select a position => (m]

Cancel Original Menu Items

=> Select an item => (@) => Release or Release All => (®] => YES => (m]

Reset Original Menu

=> (@) => Reset Org. Menu => (8] => YES => (m]
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- Clock, Display & Sounds

Standby Indicators

Enable Indicator Selector (o) => Settings => (W) => Display => @) => Icons Setting => (] => ON => (m]

- The indicators at the top of Display are enabled by pressing (8] in Standby. Use &4 to
select an indicators and press (] to access the corresponding function.

Incoming Call/Message Alerts
fo) => Settings => (8) => Incoming Call => (u]

Adjust Ringtone Volume => Ring Volume => (8] => Phone, Video Call or Mail => (8] => (7] => [m]
+ When Step is set, the ringtone volume increases every three seconds. When Silent
is set, no ringtone sounds.
Set a Ringtone => Select Ring Tone => (8] => Phone, Video Call or Mail => (8] => Select
Ring Tone => (W) = Select an item => (8] => Select a folder => (] =>Set a
ringtone
Q Set Random Playback of Melodies as | = Select Ring Tone => (] => Phone, Video Call or Mail => (®] => Select
g" Ringtones Ring Tone => (8] => Random Melody => (] => Select a folder => (m]
3 - Melodies in the selected folder are played at random as ringtones.
§. Set Ringing Duration of Incoming = Mail Ring Time = (8] = Mail = (8] => ON => (8] = Enter ringing
o  Message Ringtone duration
3 + When OFF is set, no ringtone sounds and handset does not vibrate when receiving
_m messages.
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- Clock, Display & Sounds

Set Vibration*

=> Vibrator => () => Phone, Video Call or Mail => (8] => Select a pattern => (8]
+ When Melody Linkage is set, handset vibrates to the melody set as ringtone.

Set lllumination Color

=> lllumination => (] => Set Color => (8] => Phone, Video Call or Mail =>
(@) => Select a color => (]

Set lllumination Pattern

=> lllumination => (W) => Set Pattern => (8] => Standard or Melody

Linkage => (m]

- Even when Melody Linkage is set, lllumination may not flash to the melody
depending on the set ringtone.

Set lllumination to Flash for Missed
Calls/New Messages

=> lllumination => (8] => Missed Info => (] => ON => (a]

Set an Incoming Call/Message Image

=> Select Ring Tone => (8] => Phone, Video Call or Mail => (] => Select
Calling Disp. or Select Receiving Disp. => (8] (=> My Picture or Videos =>
(m]) => Set an image/video

Show Phone Book Entry Images for
Incoming Calls/Messages

=> Disp. Phone Book Image => (8] => ON => [u]

* When Vibrator is not set to OFF, be careful not to let handset fall off a desk or slide too close to a stove, etc. when it vibrates.

b => Settings = (W) => Slide-style Setting => (u]

Open New Mail Window by Opening
Handset

=> Setting When Open => (8] => Display New Mail => (&) =>

F uoineziwoljsn)

Open Missed Calls Window by
Opening Handset

=> Setting When Open => [8) => Display Missed Call => (] =>
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- Clock, Display & Sounds

Answering Incoming Calls
b => Settings => (8) => Incoming Call => (8]

Set to Answer Calls by Pressing Any | => Answer Setting => (8] => Any Key Answer => (1]
Key - Answer incoming voice calls by pressing a key from (7], (W), (0 - (97, (%), (ceaq),
(®), () and IG8. The any key answer function is disabled for incoming video calls.

Set to Mute Ringtone by Pressing Any | => Answer Setting => (8] => Quick Silent => (]
Key + Mute the ringtone by pressing a key from (0] - (9, (33, [a=a, (€] (for voice calls
only), and K3 or by opening handset.

b = Settings => (8] => Slide-style Setting > (®]

Set to Answer Calls by Opening => Setting When Open => (8] => Answer Incoming => (8] =
Handset + When set to ON, opening handset starts call even if Answer Setting is set to Quick
Silent.
+ When set to OFF, operation follows Answer Setting.

b uoneziwolsn)
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- Clock, Display & Sounds

Manner Mode

b => Settings => (8] => Incoming Call => (8] => Manner Mode Setting => (8]

Set Manner Mode Type

=> Manner Mode Set => 8] => Select a Manner Mode => (8]
+ When Super Silent is set, all tones emitted through the earpiece are also muted.

Configure Original Manner Mode

=> Manner Mode Set => (8] => Original => (8] => Set each item =>

Set Time for Auto Manner Mode Start

=> Manner Start Time => (8] = Start Time Set1 or Start Time Set2 =
= [ => (8] = Enter time = (8] = & => (8] => 1 Time, Daily ([) or Select
Day () => (@] => (Select day => (&) =

Set Time for Auto Manner Mode
Release

=> Manner Release Time => (] => Release Time Set1 or Release Time Set2
= (&) = 03 => (8] => Enter time => (W) = & => (&) => 1 Time, Daily () or
Select Day ({ll) => (w) => (Select day = [®)) =>

Toggle Auto Manner Mode Start and
Release On/Off

=> Manner Start Time or Manner Release Time => (8] => Select an item =

- On/off toggles each time you press (). Settings (e.g., time) are not updated.
+ Use the following procedure to cancel all settings at once.
=> (@)=> Release All => (8] => YES => (m]

F uoineziwoljsn)

1413



- Clock, Display & Sounds

Checking Call Logs
b => Settings => (8) => Incoming Call => (8]

Change Colors of Names, Phone => Disp. Call/Receive No. => [B] => Select a color => (m]
Numbers and E-mail Addresses in Call |. pressing (=) toggles the color palette between 16 colors and 256 colors.
and Message Log Windows - To reset the color settings to default, press ().

Sounds

f) = Settings => (m) => Other Settings => (m]

Set to Play Charging Start/End Tones |=> Charge Sound => (8] => ON => (u]

Sound Emitted at Level 1 for First => Volume Restriction => (8] => ON => [&]

three Seconds - Applies to ring tone and alarm.
- After three seconds pass, ring tone and alarm sounds at set volume.

[ <> Settings > (W) = Slide-style Setting > (u]

Set Handset Open/Close Sound => Slide Sound => [8) => Open Sound or Close Sound => Select a sound =
(] => Ring Time => (®) => Select time sound emitted => (&)
+ Slide and close sounds not emitted when set OFF.

b uoneziwolsn)
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- Clock, Display & Sounds

e =) () = Tools => (8] => Voice Announce => (8]

Record Sound to Set as Ringtone or
Outgoing Message

=> Select an item = (@] => YES => (8] => Record sound (for about 15
seconds)
- Press (W) to stop recording.

Play Recorded Sound

=> Select an item with “%* => (&]

Delete Recorded Sound

=> Select an item with " = (@] => Erase => (8] => YES => (u]

Earphone-Microphone

b = Settings = ()

Audio Output

=> External Connection => (8] => Headset Usage Setting => (8] =>
Headset+speaker or Headset Only => (m]

Microphone Setting

=> External Connection => 8] => Headset Mic. Setting => (8] => Built-in
Microphone or Headset Microphone => (1]

Answer Calls Automatically

=> External Connection => (8] => Auto Answer Setting => () => Phone or
Video Call => (m] => ON => (] => Enter ring time

Save a Phone Number to Dial with an
Earphone-Microphone

=> Dialing => (8] => Headset SW to Dial => (8] => Voice Call => (] =>
Select a Phone Book search method => (8] => Search Phone Book = Select
an entry => (8] => Select a phone number => (1]
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- Phone Book & Calls

Phone Book

Set Preferred Search Method [Phone Book Search] window (P. 2-23) =>Select a search method = (8] =>

OK => (m]

+ To cancel the preferred search method, press in Phone Book Search window,
select the search method with “¥,” and then press (=.

Change Group Name [Phone Book Entry List] window (P. 2-23) => (@] => Group Setting => (] =>

Select a group => (8] => Edit group name => (]

+ The name remains the same only for No Group.

Do Not Send Phone Book Entry (e => Tools => (] => Forwarding Image => (8) => OFF => (u]
Images via Infrared

S! Addressbook Back-up

b = Tools = (m] => S! Addressbook Back-up => (u]

Set Auto Synchronize => Auto Sync Settings => (8] => ON/OFF => (8] => ON => (8] => Enter
Security Code => (] => Set synchronize timing => (8] (=> Set synchronize
cycle and day = [®)) => Select synchronize type => (] => YES => (®] (twice)

Check Auto Synchronize Settings Auto Sync Settings => (W) => Confirm Settings = (u]

b uoneziwolsn)
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- Phone Book & Calls

Outgoing Calls

fe) = Settings => (8] => Dialing => (u]

Save Area Code and Country Code as
Prefix Numbers

=> Prefix Setting => [®) => Select an item = (&) => Enter name => (8] =>
Enter prefix numbers => (]

Save Touch Tones

=> Pause Dial => (] => &) => Enter touch tone numbers => (m]
+ Press and hold to enter “P” (Pause).

Set Numbers after “%" as Sub Address

=> Sub-address Setting => (8] => ON => (]

International Calls

f) => Settings => (8] => Dialing => (W) => Int'l Dial Assistance => (u]

Change International Access Code
Automatically Dialed with “+”

=> Auto Int’l Call Set. => (] => ON => 8] => Select a country code => (®] =>

ERRE > )
+ When OFF is set, the international access code is not entered when you press and
hold (0.

- Select an international access code you set in IDD Prefix Setting.

Change a Country Code

=> Country Code Setting => (8] = Select an item => (8] => Enter country
name => (8] => Enter country code => (1]

uoneziwolsn)

Save an International Access Code

=> IDD Prefix Setting => (] => Select an item => &) => Enter international

access name = (®] => Enter international access code => (]

P

14-17



- Phone Book & Calls

Call Settings

b => Settings = (8) = Talk => (u]

Set Reconnection Tone

=> Reconnect Signal => (8] => High Tone or Low Tone => (m]

Set Noise Reduction

=> Noise Reduction => (8] => ON => (m]

Set Weak Signal Alarm

=> Quality Alarm => (] => High Tone or Low Tone => (1]

+ Calls may be disconnected without sounding the alarm when signal suddenly
becomes too weak.

Set Clarity of Other Party Voice

=> Hyper Clear Voice => (] => High, Low and OFF => (m]

Automatically Record During Voice
Call

=> Auto Voice Memo => (8] => ON => (u]
+ Record latest 60 seconds of call (two recordings).

Set a Hold Message

=> Set Hold Tone => (8] => On Hold Tone => (8] => Select a hold tone => (m]

Call Costs

fe) => Settings => (8] => Call Time/Charge => (8]

Set Auto Reset of Total Call Cost

b uoneziwolsn)

=> Auto Reset Total Cost => (8] = Enter Security Code => (8] => Auto
Reset => (8] => ON or OFF => (8] => Enter PIN2 => (]

+ When ON is set, the total call cost indication is automatically reset to zero at twelve
midnight on the first day of each month.
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- Phone Book & Calls

Set/Cancel a Maximum Call Cost
Limit*

=> Set Max Cost Limit => (8] => Enter Security Code = (8] => @ => (@] =>
Enter cost limit = (] => [ => (@] => ON => (m] => Set alarm tone => Set
alarm volume => (&) = Enter PIN2 => (m]

+ A call ends automatically and % appears in Display when the total call cost exceeds
the set maximum limit.

+ When the set total call cost limit has been reached, all outgoing calls are disabled. To
enable outgoing calls, set the maximum call cost limit to 0O:
=> Set Max Cost Limit => (8] => Enter Security Code = (m] => E3 => (] (twice)=>
=> Enter PIN2 => (m]

* Cost display may not be available depending on your subscription. If unavailable, you will also be unable to set a cost limit.

Video Calls

fe) = Settings = (8] => Video Call =>(m]

Set an Image to be Sent during Video
Calls

=> Select Image => 8] => Select an item => (8] => Pre-installed or Original
= (w]

+ To set an image other than the preinstalled image:
=> Original = (8] => Change Setting = (m] = Set an image

Redial Automatically as Voice Call
When Video Call Connection Fails

=> Auto Redial as Voice => (B] => ON => (u]

Set an Image to Appear in Main
Window

=> Display Setting => (8] => Main Display => (8] => Other Side or My Side
= (=]

Automatically Switch to Handsfree
Mode in Video Calls

=> Hands-free Switch => (&) => ON => (m]
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- Phone Book & Calls

Global Roaming
fe) => Settings => (8] = Int’] Roaming Set => (8]

=> NW Search Mode => 8] => Manual => (8] => Select an operator => (1]

+ When Auto is set, an available operator is set automatically.
+ Use this procedure when handset is out of the service area of the currently used

operator.

Activate Network Re-search for an => NW Search Mode => (8] => Network Re-search => (8] => Select an
Available Operator operator = E]

+ An operator is available when NW Search Mode is set to Manual.

=> PLMN Setting => 8] => Select an operator => (@) => Change Priority =>
(@) = Select a position on the priority list = (8] = (@] => YES => (&)

- When Auto or Network Re-search is set under NW Search Mode, you are
automatically connected to the highest priority operator among available operators.

Set Operator

Set Priority for Operators

Show Operator Name While Roaming | => Display Operator Name => (8] => Display ON => (u]

b uoneziwolsn)
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- Mail

S! Mail Settings
= Mail Setting > (8]

Edit Header/Signature

=> Header/Signature => (8] => Edit Header or Edit Signature => (8] (twice)
=> Edit header/signature =>

Insert Header/Signature
Automatically

=> Header/Signature => (] => Insert Setting => (8] => Header or Signature

= (m] = ([

Set to Check Delivery

=> SI Mail Settings => (8] => Delivery Report => (8] => ON => (m]

- After a recipient receives your S! Mail, a message titled S! Mail Report is sent to your
handset.

SMS Settings

=> Mail Setting -> (8] => SMS Settings -> (1]

Set to Check Delivery

=> SMS Report Request => (8] => ON => (u]
- After a recipient receives your SMS message, a message titled SMS Report is sent to
your handset.

Set Server Storage Period of SMS
Messages

=> SMS Validity Period => () => Select a period = (8]
+ When None is set, SMS messages you send are not stored on the server.

Set SMS Input Language

=> SMS Input Character => (8] => Japanese (70char.) or English (160char.)
= (]
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Incoming Message Settings

= Mail Setting > (8]

Customize E-mail Address

=> Custom Mail Address => (8] => Follow onscreen instructions

Do Not Show Emotion Indicators

=> Emotion/Keyword => 8] => Take the checkmark off from Disp. Emotion
=

Show Keyword Indicators

=> Emotion/Keyword => (8] => Put a checkmark to Disp. Keyword =>

Select a keyword entry field => (8] => Enter keyword => (8] =>

+ When handset receives an S! Mail containing the specified keyword, a keyword
indicator 4V - /@ appears.

+ In case a message contains both the content that matches an emotion indicator
(P. 5-7) and a specified keyword, the keyword indicator takes priority.

Delete Keywords

=> Emotion/Keyword => (8] => Select a keyword = ®) => Delete Keyword
or Delete All Keyword => (8] => YES => (@] =>

Set Priority When Receiving Messages
during Operation

=> Receiving Setting => (8] => Alarm Preferred or Operation Preferred =>

(w)

Set Whether to Read Out Received
Messages

=> Read Out Setting => (W) => Read Out Received Mail =>(®] => ON or OFF
= (a]

Set Voice to Read Out Messages

b uoneziwolsn)

=> Read Out Setting => (8] => Select Voice => (8] => Select a voice type =

(w)

Set Manual Receive

=> §I Mail Settings => (8] => Message Download => (8] => Manual => (u]
+ The entire text is receivable by user operation.

142



Reply Settings

Change Quotation Marks

=> Mail Setting => (8] => Header/Signature => () => Edit Quotation
Marks => (@) => Edit quotation mark => (®]

Message View Settings
= Mail Setting => (u)

& Others

Set Message List View

=> Mail List Disp. => (W) => 2 Lines, 1 Line or 1 Line+Body => (] => Subject,
Name or Address => (]

Play Attached Melodies Automatically

=> Start Attachment (auto) => (8] => ON = (=]
-+ Automatic play only for received mail.

Set Number of Text Lines to Scroll

=> Scroll => (8] = 1 Line, 3 Lines or 5 Lines => (®]

Set Font Size of Text

=> Font Size => (8] => Select a size = (m)

Check Mail Settings

=> Check Settings => (m]

Reset Mail Settings

=> Reset => (W] => Enter Security Code => (8] => YES => (m]
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SMS Server Settings

f) = Settings = [®) => Connection Settings => (8] => SMS Center Selection =>(u]

Change SMS Center Address

=> 819066519300 => 8] => Enter SMS Center address => (m] =>

International or Unknown => (]

+ Adress is 819066519300 by default. SMS may become unavailable if Center address
is changed.

Reset to SoftBank SMS Center
Address

=> Reset => @] => Enter Security Code => (@) = YES => (m]
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Internet

Internet

SRR AN CRETD Press and hold (] => Browser Settings => (8]
Sl RIS GV Press and hold () => PC Site Browser => (8] => PC Site Brw. Settings —> (8]

Set Scroll Unit/Speed

=> Scroll => (8] => Whole Page, Half Page or Single Line => (m]

Set Whether to Show Images or Play
Melodies

=> Downloads => 8] => Display Images or Play Sounds => (8] => ON or
OFF => (m]

Clear Cache

=> Memory Manager => () => Delete Cache => (8] => Enter Security Code

= (@] = YES = (]

Delete Cookies

=> Memory Manager => 8] => Delete Cookies => () => YES => (m]

Initialize Memory Status of Internet

=> Initialized Browser => (8] => Enter Security Code => (8] => YES => (u]

Set Whether to Send Manufacture
Number

=> Security => (8] => Manufacture Number => (8] => ON or OFF => [u]

Set Whether to Send Referer

=> Security => (8] => Send Referer => (8] => ON or OFF => (m]

Enable/Disable Cookies

=> Security => (] => Cookie Settings => (8] = Select an option => (8]

Set Whether to Activate Scripts

=> Security => (8] => Script Settings => () => Select an option => (&)

Check Internet Settings

=> Check Settings or Check PC Site Brw. Set => (m]

(o]
[
(U]
-
o
3
N
[
[=
o
3

Reset Internet Settings

=> Reset or Reset PC Site Brw. Set => (8] => Enter Security Code => (8] => m_

YES => (m]
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- Internet

Yahoo! Keitai

St Press and hold () => Browser Settings => (8]

Set Font Size => Font Size => (®) => Select a size => (m)
Set Flash® Sound On/Off => Flash Sound Effect => (8] => ON or OFF => (u]

PC Site Browser

Press and hold () => PC Site Browser => (8] => PC Site Brw. Settings = (8]

Do Not Show Alert When Activating |=> Warning Messages => (8] => OFF => (m]
PC Site Browser & Switching Browsers

=> Display Mode Settings => () => PC Screen or Small Screen => (8] =>

Set Page Layout
Select a size = (m)

Network Connection Settings

Set Whether to Send Location (e => Settings => (W) => Send Location Info => (8] => Enter Security Code
Information => (m] => Confirm, Send or Not Send => (u]
+ Set to Confirm or Send to obtain information.
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TV

Channel List
[y => TV => (@) => Channel List > (a]

Change Title of Channel List

=> Select a channel list = (@) => Edit Title = (®] => Edit title => (®]

Delete a Channel List

=> Select a channel list => (@] => Delete This => (8] => YES => (m]
+ The currently used channel list cannot be deleted.

Assign Channels to Remote Control
Numbers

=> Select a channel list => (2] => (@) => Remote Control No. => (] => Select
a remote control number => (8] => Select a channel => (8] => Repeat the
same step = (&) => YES = (u]

Delete a Channel

=> Select a channel list = |®] => Select a channel => |®] => Delete This =
(m] = YES => (m]
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Image & Sound
fe) = TV => (m] => User Settings => (8]

Set Subtitle Display => Subtitles => [8) => ON (Wide: Bottom), ON (Wide: Top) or OFF => (m]

Show/Hide Icons in Landscape View |=> Icon Always Show => (8] => ON or OFF => [u]
- Icons other than for program title no longer displayed if set to OFF.

Save Battery by Dimming Backlight |=> TV Power Saving => (] => YES => (&]

Keep Backlight Lighted While => Display Light => (8] => Constant Light => (&)

Watching TV

Set Time Backlight Stays Lit While => Display Light => (8] => Lighting Duration => (8] => Enter lighting time
Watching TV > (m]

Set Sound Effect => TV Effect = (8) => Sound Effect => (] => Select an effect = (m]

Set Visual Image Effect => TV Effect => (8) => Visual Image Effect => (8] = Select an effect => (1]
Set TV to Pause or Continue for => Time Shift Setup => (8) => Auto ON or Auto OFF => (]

Incoming Calls (Time Shift Playback)
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Data Broadcasts

b = TV => (m] => User Settings => (8] => Data BC Settings —> (8]

Set Whether to Show Images in Pages
Accessed from Data Broadcasts

=> Set Image Disp. => (8] => ON or OFF => (m]

Enable/Disable Sound Effects of Data
Broadcasts

=> Sound Effect => (] => ON or OFF => (m]

Set Whether or Not to Show
Confirmation Window Again

=> Reset Disp. Set. => (] => YES or NO => (u]

+ Once you select YES (By default) in a confirmation window for accessing a web
page from Data Broadcast, the window no longer appears. Use this procedure to set
the window to reappear.

Recording Programs

Continue/End Recording at Low
Battery

bew) => TV => (m] => User Settings => (8] => Rec. While Low Battery => (8] =>
ON or OFF => (u]
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Other Settings

fe) = TV => (m] => User Settings => (8]

Check TV Settings

=> Check TV Settings => (m]

Reset Channel Settings

=> Reset Channel Setting => (8] => Enter Security Code => (] => YES => (m]

Clear Data Broadcast Memory

=> Reset Storage Area => (8] => Select an affiliated station = (@) =>
Delete This or Delete All => (] (=> Enter Security Code => (®]) => YES =>

(w)

Rest TV Settings

=> Reset TV Settings => () => Enter Security Code => (8] => YES => (a]
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- Camera

Cameral/Video Settings

Set Image Quality

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®] => Quality
Setting => (8] = Select a quality = (u]

Set File Size

[Video Viewfinder] (P. 7-7) => => Select a file size => (®]

Set White Balance

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) => (6 => Select an

item => (m]

- In Photo Viewfinder, you need to set Photo Mode (P. 7-13) to OFF before setting
white balance.

Reduce Flicker

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®] = Camera
Settings => (W] => Flicker => (8] => Auto, Mode 1 (50Hz) or Mode 2 (60Hz)

=> (m]

Set Shutter Sound

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®) => Shutter
Sound => (®] => Select a shutter sound = (m]

Set Display for Handset Closed
Shooting

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = (&) = Icon
Always Show => (8] => ON or OFF => (u]

+ Below icons do not appear if set to OFF.
@ Photo Viewfinder
Focus Frame, Auto Timer, Number of Files That Can Be Saved
@ Video Viewfinder
Auto Timer, Storage Capacity, Recording Status, Recording Time (remaining)

Set Interval for Continuous Shooting

[Continuous Shooting Viewfinder] (P. 7-10) => (®) => Interval/Number =>
(@) = Shot Interval => (®] => 0.5 Seconds, 1.0 Seconds or 2.0 Seconds =>

(w]
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- Camera

Set Number of Shots for Continuous |[Continuous Shooting Viewfinder] (P. 7-10) => (®) = Interval/Number =>
Shooting (@) => Shot Number => (8] => Enter Shot Number => (u]

File Storage & Continuous Shooting

Set Storage Location for Shot Still [Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = @] => Select to
Images/Videos Save = (®] = Phone or microSD => (] => Select a folder => [m]

- To save videos on memory card, select a folder of Inbox.
Save Shot Still Images/Videos [Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®) => Auto save
Automatically Set => (m) => ON => (m]

- Still images and videos shot with handset camera are saved to the folders specified
in Select to Save.
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- Player & S! Appli

Playback Window

Change Playback Window Mode

[Video Player Playback] window (P. 9-5) => (@] => Action Setting = (] =>

Screen Setting => (8] => Normal Screen Mode or Full Screen Mode => (u)

Change Design of Playback Window

[Music Player Playback] window (P. 9-5) => (@) => Action Setting => (®) =>

Change Skin => (] => Select a design => (]

Set Image Display Size

[Video Player Playback] window (P. 9-5) => (@] => Action Setting => (] =>

Set Image Disp. => [8) => Normal or Fit in Display => (]

When Running S! Appli

[ = S1 Appli => (B) => Settings > (8]

Set Sound Volume

=> Sound)/Vib Settings => (8] => Volume => (8] => ({] to adjust volume =>

(w]

Set Vibration

=> Sound/Vib Settings => (] => Vibration => (8] => ON or OFF => (u]

Set Backlight

=> Backlight Settings => (8] => Switch ON/OFF => (m] => Always ON,
Always OFF or Link To Phone Set. => (]

Set Blinking of Backlight

=> Backlight Settings => (8] => Blink => (8] => ON or OFF => (m]

SERNEE () => ST Appli => (B) => S! Appli List => (8]
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Allow/Prohibit S! Appli to Connect to
Network

=> Select an S! Appli = [®) => Security Settings => (] => Net Access = (8]

=> All Permit, Prompt at 1st only, Prompt each time or Disable => (m]
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- Player & S! Appli

Allow/Prohibit S! Appli to Write => Select an S! Appli = (@) => Security Settings => (8] => Write User Data

Personal Information => (m] => All Permit, Prompt at 1st only, Prompt each time or Disable =>
(m]

Reset Security Settings of S! Appli => Select an S! Appli = (@) => Security Settings => (W) => Reset Security
Set. => (m] => YES => (m]

S! Appli Settings
b => S1 Appli => (8] => Settings => (m]

Reset S! Appli Settings => Reset => (W] => Set to Default => (8] => Enter Security Code => (8] =>
YES = (m]

Delete All S! Appli => Reset => (8] => Delete All S! App => (8] = Enter Security Code => (@] =
YES = (m]
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- Entertainment

Mobile Widget Settings

fe) = Entertainment => (8] => Mobile Widget => (m] => Settings —>(u]

Set Whether to Use Mobile Widget

=> Standby Disp. Set. => (8] => ON or OFF => (m]

Check Auto Synchronize Settings

=> Auto Refresh => (8] => ON or OFF => (m]

Set Whether to Automatically

=> Auto Roaming => (] => ON or OFF => (u]

Transmit When Abroad
Delete All Widgets from Desktop => Delete Content => (] => Select a Desktop page = (8] => YES => (m]
Page - All Widgets in selected Desktop page are deleted.

Set Whether to Use Cookies

=> Cookies => (@) => ON or OFF => (m]

Delete Cookies

=> Delete Cookies => (@] => YES => (m]
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- Entertainment

S! Quick News
f) = Entertainment => (8] => SI Quick News => (8] => Settings => (m]

Hide S! Quick News in Standby => Standby Settings => (8] => Standby Disp. Set. => (8] => OFF =>
(m] (twice)
Set Ticker Speed => Standby Settings => () => Speed Settings => (8] => Fast, Normal or

Slow => (] (twice)
Set Information to appear in S! Quick |=> Standby Settings => (8] => Unread & Read Set. => [8) => Unread Only

News or Unread & Read => (8] (twice)

Hide S! Quick News Images => Set Image Disp. => (8] => OFF =>(®] (twice)

Reset S! Quick News Registered => Del. Quick News => [8) => YES => (8] (twice) = Enter Security Code =>
Contents (®) (twice)
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- Entertainment

S! Info Channel

f) => Entertainment => (8] => S! Info Ch./Weather => (8] => Settings > (8]

Set Whether to Display Desktop Icon
For New Received Information

=> S!I Information Notif. => (] => ON or OFF => (m]

Set Font Size for Web Pages

=> Font Size => (8] => Select font size => (m]

f) = Settings => (] => Display => (8] => Font => (u]

Set Font Size

=> Character Size => (8] => Separate Setting => (] => S! Info Ch. => (m] =>
Select font size => (]

Weather Indicators

{» = Entertainment => (] => S! Info Ch./Weather => (8] => Weather Indicator = (8] =

Settings = (1]

Set Whether to Automatically Update
Weather Information

=> Weather Update => (8] => ON or OFF => (m] (=> YES => (m))

Set Whether to Display Weather
Indicators in Standby

=> Standby Setting => (8] => ON or OFF => (]

Set Whether to Display Desktop Icon
For New Received Information

=> Weather Notif. => (8] => ON or OFF => (m]
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- Other Settings

b uoneziwolsn)

Text Entry

fe) => Settings => (8] => Other Settings => (] => Character Input Set => (8]

Set Text Input Method

=> Input Mode => (8] => Select an input method => (m]

Set Word Prediction

=> Prediction => (8] => ON or OFF = (u)

Set to Show T9 Suggestion Words in
Kanji or Hiragana

=> T9 Change Mode => (8] => T9 Kanji Change Mode or T9 Kana Change
Mode => (m]

Clear Learning History

=> Clear Learned => (8] => Enter Security Code => (] => T9/Expect Words/
Pic. or Kana/Kanji Change/Face => (8]

Change Font Size

=> CHG Input Size => (] => Select a size => (W]

Set Auto Cursor Movement in 5-Touch
Mode

=> Auto Cursor => (8] = Fast, Normal, Slow or OFF => (a]

Key/Touch Sensor

fe) = Settings => (] => Key/Touch Sensor => (8]

Set Key/Touch Sensor Sound Off

=> Keypad Sound => (8] => OFF => (m]

Change Function Assigned to Shortcut
Key

=> Shortcut-key Setting => (8] => Select a function => (8] => YES => (m]

+ Alternatively, press and hold (®] in Standby to set Shortcut-key Setting.
- To return to original settings, press (@), select Reset Shortcut-Key, and press ().

1438



- Other Settings

Set Touch Sensor Backlight

=> Touch Sensor Setting => (8] => ON => (8] => Backlight => (8] => Select a

color => (m)

Set Vibrator and Illlumination for
Touch Sensor Operation

=> Touch Sensor Setting => (8] => ON => (] => Touch Sensor Linkage =>
(] => Vibrator or lllumination => (] => ON or OFF => (m]

Set Touch Sensor Scroll

=> Touch Sensor Setting => (8] => ON => (8] => Scroll => (8] => ON or OFF

=> (]

+ Touch Sensor scrolling will be available for web pages and Message Details window

when set to ON.

Set Not to Use Touch Sensor

=> Touch Sensor Setting => (8] => OFF => (m]

Key lllumination

SERLEE) (o) => Settings = (8] = Hllumination => (8] => Key Hlllumination => (8] => ON => (m]

Set lllumination for Power On/Off

=> Power ON or OFF => (®] => Set Pattern => (8] => ON or OFF => (®]

Set Flashing Color for Power On/Off

=> Power ON or OFF => (®] => Set Color => (8] => Select a color => (]

Set Flashing Pattern for Call Start

=> Talking Start => (8] => Set Pattern => (8] => Select a pattern => (m]

Set Flashing Color for Call Start

=> Talking Start => (8] => Set Color => (®] => Select a color => (m]

Set lllumination for Emotion-
Expressing Mail

=> Emotion => (8] => Always, Unread Mail Only or OFF => (m] => Scroll =>

(=] => ON or OFF => (m]
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Set Flashing Pattern for Alarm
Notification

=> Alarm => (] => Set Pattern => (8] => Select a pattern = (]
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- Other Settings

Set Flashing Color for Alarm => Alarm => (8] => Set Color => (] => Select a color => (m]

Notification

Set lllumination for Snooze => Snooze = (W) => Set Pattern => 8] => ON or OFF => (m]

Notification

Set Flashing Color for Snooze => Snooze => (8] => Set Color => (m] => Select a color = (u]

Notification

Set Illlumination for Ir/IC Transmission |=> Ir Exchanging or IC Exchanging => (8) => Set Pattern => (8] => ON or
OFF => m]

Set Flashing Color for Ir/IC => Ir Exchanging or IC Exchanging => (8] => Set Color => (] => Select a

Transmission color = (m)

llluminate When Charging Begins => Charge Starting => (8] => Set Pattern => 8] => ON or OFF => (u]

Set Flashing Color (When Charging | => Charge Starting => (8] => Set Color => (] => Select a color => (u]

Begins)

Set Flashing Pattern for Handset => Open or Close => (W) => Set Pattern => 8] => ON or OFF => (a]

Open or Close

Set Flashing Color for Handset Open |=> Open or Close => (8] => Set Color => (] (=> YES => (m]) => Select a color
or Close > (m)
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- Other Settings

Key Backlight

SERdEEE) b = Settings => (8] = Hlumination => (u]

Set Key Backlight Color

=> Key Backlight => () => Select a color => (m]

Set Key Backlight Off

=> Key Backlight => (] => OFF => (u]

Osaifu-Keitai®

Set illumination for IC Card

(e => Tools => (@) => Osaifu-Keitai => () => IC Card Illlumination => (®] =>
ON or OFF => (u]

Delete all Lifestyle-Appli

(e => SI Appli => (8] => Settings => (8] => Reset => (8] => Delete All
LifeApp => (8] = Enter Security Code => (8] => YES => (m]

Set Whether to Enable Opening from
Browser

fe) => Tools => (W) => Osaifu-Keitai => (W) => Interface Settings = (8] =>
Enter Security Code => 8] => Browser => (8] => ON or OFF => (m]
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- Other Settings

Bluetooth®

fe)=> Tools => (8] => Bluetooth => (8] => Bluetooth Settings —> (u]

Set Detection Time for Device => Time-out to Search => (8] => Enter search time => [u]

Set Whether to Send Ring Tone for  |=> Forward Ring Tone => (8] => ON or OFF => (u]

Voice Call, Video Call to Headset or  |. ging tone will also sound from handset if Headset Usage Setting is set to
Handsfree Device Headset+speaker and Forward Ring Tone is set to OFF.

Set Whether to Enable Calling from => Dial From Other Device => (8] => Valid or Invalid => (m)
External Device
Check Handset Bluetooth® => Bluetooth Info => (m]

Information « Press (&) to change name of added device.

Resetting Handset
f) = Settings => (m) => Other Settings = (m]

Reset All Settings to Default => Reset Settings => (B] => Enter Security Code => (8] => YES => (m]

Initialize Handset to Default Status | => Initialize => (8] => Enter Security Code => (8] => YES => (8] => YES => (u]

+ When the initialization is completed, handset automatically shuts down and restarts.

+ When handset is initialized, all data downloaded and saved on handset are deleted
and cannot be restored.

+ Your Security Code will also be reset to default.

b uoneziwolsn)

1442



	Customization
	Clock, Display & Sounds
	Phone Book & Calls
	Mail
	Internet
	TV
	Camera
	Player & S! Appli
	Entertainment
	Other Settings




